
 
Administrator Quick Reference 

Virtual TimeClock® Network 

Your time clock program runs in either User or Administration mode. User mode is where 
workers clock in and out and view their timecard. Administration mode is where program 
administrators and managers edit and print timecards, close payroll, and configure the time 
clock options. This quick reference guide covers the Administrative mode of Virtual TimeClock.  

Turning Administration On 
To enter Administration mode, select Turn Administration On from the File menu. If security is 
enabled, you will be required to enter your administrator or manager password to turn on 
Administration. 
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Administrative Actions 
The administration window consists of an administrative toolbar and an in & out list of users 
showing their current status. Each administrative action is discussed below. 

 

Editing & Deleting Entries 
Entries can be selected by worker for any date range. Once the selected entries have been 
displayed, you can modify or delete them. Click Entry Editor. 
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Double-click an entry 
to edit the punch time. 

Modified entries are 
flagged with an ‘M’ 
on timecard reports.

Timecards can also be 
edited from the toolbar 
of the report window.



Clearing Entry Errors 
Virtual TimeClock will automatically prompt users returning to work when they have missed a 
prior clock out. The entry is flagged and marked with an error on their timecard. A time clock 
manager or administrator uses the Entry Editor (see below) to enter the correct stop time and 
uncheck “Stop Error” checkbox for a missed clock out. Click to learn more about the missed 
stop feature. 

Adding Manual Entries
Sometimes you’ll need to record timecard entries manually, like to give a worker credit for time 
worked offsite or when they forget to clock in. Click Add Entry. 

Adding leave entries 
You can add leave entries for holidays, personal time, sick leave, vacation, or any leave 
category you’ve created. Click Add Leave. Click to learn how to assign leave awards to users. 
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Manual entries are 
flagged with an ‘A’ on 
timecard reports.

Leave awards and 
categories can be 
added in the Configure 
window.

https://www.redcort.com/virtual-timeclock-knowledge-base/features/time-calculations/missed-clock-out-errors
https://www.redcort.com/virtual-timeclock-knowledge-base/features/time-calculations/missed-clock-out-errors
https://www.redcort.com/virtual-timeclock-knowledge-base/features/holidays-leave-and-vacation-tracking/leave-awards


Printing Timecards 
Virtual TimeClock comes with built-in reports that allow you to print employee timecards by 
activity, department, leave category, shift, or person. You can also print summary reports for 
management, accounting, or payroll entry. Click the Reports menu to print or save timecards as 
a PDF. 

Program reports 
User contact lists, telephone lists, late arrival, user status and profile reports can also be printed 
from the Reports menu. 

Editing report favorites 
Reports that you run often can be added to the toolbar so they’re easy to find and print. Click 
My Reports. 

Exporting Reports 
Timecard reports can be exported to a text file for analysis or imported into your payroll program 
by clicking Export. Click the Setup button in the Export window to choose the file format and 
select what fields to export. Click to learn more about exporting report data in Virtual TimeClock. 
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Timecard Detail is the 
default worker timecard.

Timecard reports can be 
customized by clicking 
Report Writer in the 
Configure window.

https://www.redcort.com/virtual-timeclock-knowledge-base/features/exporting/export-overview


Payroll Approval 
Payroll approval is what you do when you're ready to review timecards, generate a payroll 
report, export the hours to a payroll program, and close the payroll period. The Payroll Approval 
dashboard will automatically calculate all regular, overtime, and paid leave hours for the current 
payroll period. Click to learn more about payroll approval in Virtual TimeClock. 

Review & Approve Hours 
Click All Timecards to quickly review the hours worked for each employee in more detail, 
including the individual punch times. You can click Sign off All to approve all hours at once, or 
sign off timecards individually by clicking on an employees name. Signing off indicates that the 
hours are accurate and ready for payroll processing. 

Payroll Hours Report 
The Payroll Summary report provides a permanent record of all hours worked for the payroll 
period grouped by hourly workers, salaried workers, workers with no hours for the payroll 
period, and workers with timecards that have not been signed off. 

Payroll Integration File 
You can export a specially formatted file of employee hours that can be imported into several 
popular payroll programs. If you’re not set up for payroll integration, you can still print the Payroll 
Report for a listing of employee hours that can be manually entered into your payroll system or 
called in to your payroll processor. 

Close Period 
Once all hours for a payroll period have been reviewed, the Payroll Summary report printed, and 
employee hours exported, the payroll period should be closed. Hours for all workers must be 
signed off before closing the payroll period. Closing the payroll period will automatically advance 
the current period starting and ending dates to the next payroll period based on your payroll 
settings. 

6

Electronic timecard 
approval can be enabled by 
going to Configure Payroll 
Settings.

You can still view timecards 
and payroll reports from 
prior periods by clicking the 
calendar icon.

Timecard errors will have to 
be corrected before you can 
perform payroll approval and 
close the period. See 
Clearing entry errors in 
Administrative actions for 
details.

https://www.redcort.com/virtual-timeclock-knowledge-base/features/payroll/timecard-approval-for-payroll


Why closing payroll periods is important 
Virtual TimeClock will use the stored totals from a closed payroll period when running timecards 
rather than recalculating the totals again based on the current settings for each employee. This 
is important since wages, overtime, and time deduction rules may have changed. Click to learn 
more about closing periods in Virtual TimeClock. 

Messaging 
Messaging functions like a simple, self-contained email system. Workers can use messaging to 
notify managers of a missed punch time or request a day off. Managers can communicate 
directly with workers or broadcast notices of meetings or other company information. Click 
Messaging to open your mailbox. Click to learn more about the messaging feature of Virtual 
TimeClock. 
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https://www.redcort.com/virtual-timeclock-knowledge-base/features/payroll/closing-payroll-periods-overview
https://www.redcort.com/virtual-timeclock-knowledge-base/features/messaging/messaging-overview
https://www.redcort.com/virtual-timeclock-knowledge-base/features/messaging/messaging-overview


Configuration Overview 
The Configure window is where you set up and customize your time clock. You can open the 
Configure window from the administrative toolbar. Configuration settings are grouped in the 
categories shown below. 

People 
Use these settings to create and edit time clock users, create shifts & schedules, assign leave 
awards, create and assign departments, configure and assign overtime rules, and create and 
assign auto time deductions. 

Groups 
Use these settings to create and edit display groups, create activities, create out memos, 
configure breaks & lunches, and customize report options. 

System 
Use these settings to define your payroll period, set time & rounding rules, configure global 
security settings, view your company registration information, and review program logs. 

Data 
Use these settings to troubleshoot your database and schedule database backups. 
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Users 
Virtual TimeClock users include employees who use the time clock to punch in and out, 
managers who need to monitor their worker's activities, and time clock administrators who have 
unlimited access to all time clock functions. Users can be added manually or imported. 

Importing users 
Users can be imported from a CSV or QuickBooks IIF file. Click Add, then Import Users and 
follow the instructions for creating the import file. 

Groups 
Users must be assigned to at least one display group in order to clock in and out. Managers can 
be assigned to multiple display groups as both a display group user and a display group 
manager. Administrators only need to be assigned to a display group if they’ll be keeping track 
of their time. 

Password 
When using the In & Out Board display group interface, new users will be prompted to create a 
password the first time they select their name. When using the PIN or Passcode interfaces, the 
user’s first password will have to be created for them. 

Making users inactive 
Making a user inactive will remove the employee from all display groups, but you’ll still be able 
to view their timecard history. Deleting the user will also delete their entire timecard history. Click 
to learn more about inactivating time clock users. 
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Each user must have a first 
and last name. All other 
information is optional and 
can be added anytime.

Click the Notes tab to 
record things like safety 
training, wage history, and 
employee reviews.

Use the Show button at the 
bottom of the User list to 
filter which users are 
displayed.

https://www.redcort.com/virtual-timeclock-knowledge-base/features/users-managers-administrators/adding-removing-managers
https://www.redcort.com/virtual-timeclock-knowledge-base/features/users-managers-administrators/adding-removing-administrators
https://www.redcort.com/virtual-timeclock-knowledge-base/features/users-managers-administrators/deleting-and-inactivating-users


Departments 
Departments allow users to be grouped by role, shift, or location so you can run reports for labor 
costing and productivity analysis. The department assigned to the user receives credit for all 
activities performed by that user. 

Overtime 
You can set the rate and threshold that overtime hours are calculated at. If no overtime rule is 
assigned to a worker, then all daily and weekly hours are calculated as regular hours worked. 
Click to learn more about tracking overtime in Virtual TimeClock. 
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If your employees perform 
work for multiple 
departments, you may want 
to use activities to track their 
time instead.

Since you can assign a different 
overtime rule to each user, it’s 
easy to place employees on 
alternative work schedules.

https://www.redcort.com/virtual-timeclock-knowledge-base/features/overtime/overview-of-overtime


Auto Time Additions & Deductions 
Auto time additions and deductions allow you to automatically add or deduct time from 
employee timecards without those employees interacting with the TimeClock.  

Shifts 
Shifts are clock in and clock out rules that help you control unnecessary overtime because you 
can set what happens when employees punch in or out outside of their scheduled work hours. 
Shifts can also be used to track employee tardiness and automatically clock out employees who 
forget to clock out on their own. 
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Example: Automatically 
deduct lunch breaks 
from your warehouse 
workers while still 
requiring other workers 
to clock in and out for 
lunch breaks.



Setting up shifts 
Setting up shifts is a two-step process: First, create the new shift and define your restrictions. 
There are two types of clock-in and out restrictions. The first type of restriction allows 
employees to clock in early but records their actual start time as their shift start time. The 
second type of restriction prevents employees from clocking in before their shift starts within a 
defined grace period. Clock-out restrictions work the same way, except the rules are applied to 
employee stop times. Find more information in the Shifts and Schedules article on our website. 

Schedules 
The second step is to assign a shift to the user schedule for each day of the week. 
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Clock in and out 
restrictions are not 
needed to track 
employee tardiness or 
use the auto clock out 
feature.

All automatic clock outs 
record the stop time as 
the shift end time.

“Unscheduled” will 
automatically be 
assigned to each day 
that’s left without an 
assigned shift.

https://www.redcort.com/virtual-timeclock-knowledge-base/features/shifts-and-schedules/overview-of-shifts


Leave Categories 
Virtual TimeClock includes several common leave categories. These are holiday, personal, sick 
leave, and vacation. You can add as many additional leave categories as you want and 
designate how they are paid. Click to learn how to create additional leave categories. 

Leave Awards 
Leave benefits can be accrued daily, monthly, given as a yearly allotment, or calculated based 
on hours worked. There are several built-in leave reports available from the Reports menu. 

Adding leave awards 
Select a leave category to assign an award frequency, number of hours awarded, and 
anniversary day. Click to learn more about adding leave entries in Virtual TimeClock. 

Leave carryover 
Leave balances can be carried over from a previous benefit year and entered into the 
Carryover Hours field for each leave category. Click to learn how to carryover hours in Virtual 
TimeClock. 
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Run the Accrual Report 
to find out how much 
leave each user has 
remaining at the end of 
their benefit year.

https://www.redcort.com/virtual-timeclock-knowledge-base/features/holidays-leave-and-vacation-tracking/leave-categories
https://www.redcort.com/virtual-timeclock-knowledge-base/features/holidays-leave-and-vacation-tracking/entering-leave
https://www.redcort.com/virtual-timeclock-knowledge-base/features/holidays-leave-and-vacation-tracking/end-of-year-leave-carryover
https://www.redcort.com/virtual-timeclock-knowledge-base/features/holidays-leave-and-vacation-tracking/end-of-year-leave-carryover


Groups Configuration 

Display Groups 
Display groups allow you to set what program rules are in use for your time clock, including 
what interface employees will use to open their user status window. 

Benefits of display groups 
Use display groups to: 

• Assign workers to only use specific time clocks 
• Limit what activities and out memos workers can select when recording time 
• Control user and manager access to program features 
• Assign shifts and shift rules to groups of users 
• Choose what reports users and managers can view and print 
• Set the default activity, out memo, and worker timecard for the group 
• Change the time clock interface from an In/Out Board list to PIN, Passcode or Individual 

Group password 
Although a group password is not required for a client login, it’s a good idea to set one up if 
you’re looking for additional security. With an individual interface, a user password is always 
required to login. 

Changing Display Groups 
Change the display group by selecting Logout of Display Group from the File menu. 
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TimeClock Users is the 
default program display 
group.

A user can be assigned 
to more than one 
display group.

https://www.redcort.com/virtual-timeclock-knowledge-base/features/display-groups/overview-of-display-groups
https://www.redcort.com/virtual-timeclock-knowledge-base/features/display-groups/group-users-permissions
https://www.redcort.com/virtual-timeclock-knowledge-base/features/display-groups/group-managers-permissions
https://www.redcort.com/virtual-timeclock-knowledge-base/features/shifts-and-schedules/overview-of-shifts
https://www.redcort.com/virtual-timeclock-knowledge-base/features/display-groups/time-clock-interface-options


Activities 
All time clock entries are recorded with an activity, which allows employees to assign time to 
specific tasks, jobs, projects, functions, or locations. To learn more about activities, review the 
Overview of Activity Tracking Knowledge Base article on our website. 
 

Activity status 
The activity status determines when an activity can be selected. Most activities should be 
available when clocking in but some activities should only be available when adding manual 
entries, like when giving a worker credit for travel time or offsite training. 

Out Memos 
Out memos are temporary notes that are left when an employee stops working and are not 
included on employee timecards. 
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Users can create a one-time  
custom memo when stopping 
work, like “Back by 3 PM”

The ability to create custom 
memos is a user action that 
needs to be enabled for the 
display group.

Only paid activities are 
included in the total 
hours worked for each 
employee.

The ability to create new 
activities on-the-fly when 
starting work is a user 
action that needs to be 
enabled for the display 
group.

https://www.redcort.com/virtual-timeclock-knowledge-base/features/tracking-hours/activity-tracking-overview


Breaks & Lunches 
Going on break or taking a lunch automatically records a stop time for the existing activity. 
Employees can choose a new activity or continue an existing one when returning. 

Setting break limits 
Since only paid breaks and lunches are included in the total hours worked for each employee, 
you can limit paid breaks and lunches until a maximum time threshold is reached. 

Report Writer 
The built-in Report Writer allows you to create, copy, and customize timecard reports. 
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If you have a 
default report that 
you’ve customized 
and wish to keep, 
change the report 
name before 
restoring default 
reports.



Time Totals 
Total hours on reports can either be displayed as decimal hours (8.25) or hours and minutes 
(8:15). 

Include Who 
Click the Selection & Sort button to choose what timecard entries are to be selected, and how 
they are to be grouped and sorted for each timecard report. 

Display 
Click the Report Options button to include subtotals, gross wages, leave and activity 
summaries, employee identification numbers, social security numbers, timecard notes, optional 
report columns, and signature lines. 

Format 
Click the Font & Layout button to change the page layout for each timecard report, including 
margins, font size, line spacing, font, and the orientation of the report. 

Date Range 
You can set the default date range for the report. In most cases, this will be the current period. 

Restoring default reports 
Click the Tools button to restore the original settings of the default reports if they are lost 
through customization or accidentally deleted. 
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You can customize your 
worker signature line by 
clicking the Signature 
Text button.



System Configuration 

Payroll Settings 
The payroll period settings define your payroll period frequency (how often you get paid), allow 
you to set your current payroll period, and enable electronic timecard approval. For more 
information about payroll periods, review this article. 

Reopening a closed payroll period 
If a payroll period is closed early, any new entries for the closed period are recorded but not 
totaled when timecards are printed. You also can’t edit entries until the period is reopened. 
Select Reopen Prior Period to edit entries in a past payroll period. 

Note: If you reopen a prior period, current time clock settings will apply to the entries. 

Electronic Timecard Approval 
When electronic timecard approval is enabled for hourly workers, the default user timecard 
report will contain an approval header that allows users to electronically approve their timecard. 
Salaried workers will have the option to approve their paid leave time for the payroll period. 
When electronic timecard approval is enabled for managers, the Payroll Approval dashboard will 
contain the option for managers to approve timecards for workers within their group. Approval is 
simply a way to document that the timecard has been reviewed. 
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https://www.redcort.com/virtual-timeclock-knowledge-base/features/payroll/closing-payroll-periods-overview


Time Settings 
These settings control where the time clock gets its time stamp, when the workweek starts, and 
how start and stop times are rounded on timecards. 
 

Security 
Password-protecting administrative features will prevent employees from editing their own 
timecards, overriding shift restrictions, and buddy punching. You can also set what password 
rules are in use for your time clock. 
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Start and stop times can 
be rounded to the nearest 
tenth (6 minute intervals) 
or quarter hour (15 minute 
intervals).

PIN interface users are 
only affected by the 
minimum password 
length rule.

Users can change their 
passwords from the 
Actions menu of their 
User Status window.

https://www.redcort.com/virtual-timeclock-knowledge-base/features/time-calculations/time-rounding


Licenses 
The registered company name and address will appear on the top of all reports. To change your 
company name or address, please contact Redcort Software. If you have not purchased a 
license, visit our store page for pricing information or contact us is you need a copy of your 
license. 

Program Logs 
Program Logs are a valuable resource when determining what system processes occurred, who 
initiated the process, and when. 
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https://www.redcort.com/store
https://www.redcort.com/contact


Audit logs 
Use the audit logs to view modifications to timecards, when manual entries are added, and 
when payroll periods are closed. 

Backup logs 
Use the backup logs to verify scheduled backups were successful. 

Error logs 
The error logs may help in determining the events surrounding an unexpected program 
termination or other uncharacteristic program behavior. 

Information logs 
The information logs record general program information. 

Database 
Virtual TimeClock uses an embedded SQL database engine that manages your company data 
file, which contains all user information, timecard entries, messages, and configuration settings. 

You can create and use multiple company data files, but most companies will create a single 
data file that is used by all workers. 

Troubleshooting 
If Virtual TimeClock begins to produce unexpected results, the first thing to do is quit and restart 
the program. If that doesn’t resolve the problem, shut down and restart the computer and then 
test the functionality of Virtual TimeClock again. 

If the above steps don’t help, you can Verify your database file is in good working order and 
Reindex the database tables.  
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Backup Schedule 
The built-in backup utility allows you to easily and quickly perform a one-time manual backup or 
schedule daily or repeating backups. Backups are performed and scheduled from the Virtual 
TimeClock Server Manager. Click to learn how to backup your time clock data. 

Moving and restoring your time clock data 
You may need to restore your database from a backup file for a variety of reasons. The two 
most common are hardware failure and needing to move Virtual TimeClock to another 
computer. Review the Network Edition Server and Client moving guide for more information. 

Server Connection 
This window displays current server and connection information, including the Public IP of your 
TimeClock Server computer that can be used for remote connectivity. 
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Don’t store backup files 
on the same hard disk 
as your database, or a 
single disaster can wipe 
out all of your data.

You should periodically 
check the program 
logs to verify your 
backup is successful.

https://www.redcort.com/virtual-timeclock-knowledge-base/features/backups/manual-backups
https://www.redcort.com/virtual-timeclock-knowledge-base/install/moving/moving-server
https://www.redcort.com/virtual-timeclock-knowledge-base/install/moving/moving-client


Assistance & Technical Support 
See the Help menu for online support resources, blogs, and troubleshooting articles. We 
include 30 days of complimentary technical support with your new software license. Our optional 
annual Software Maintenance & Support program provides ongoing technical support and free 
software upgrades. If you are not enrolled in Maintenance and Support and need assistance, a 
technical support incident may be purchased at any time. 

Copyright 1986-2025 Redcort Software Inc. All Rights Reserved. Virtual TimeClock and Virtual TimeClock Pro are registered 
trademarks of Redcort Software Inc. All other names mentioned are trademarks or registered trademarks of their respective holders 
in the United States and other countries. 

                   	 	 	 	 	 	 	                          	                Revised 10.01.2025
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